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Creating good presentations can be thought of in three @
stages — today’s brown bag concentrates on the third, most

tactical one

Strategic
Mess age . Preser.ltatio.n §tructure -
. » Pyramid principle, problem definition
d@Slg N - Persuasive arguments — qualitative and quantitative

» Simplicity of message for each slide

« Clarity in identifying part of chart or table of most
interest

* Mu-Sigma Way: talking headers, take-away
boxes etc

 Aesthetics issues (use of graphics, sufficient
white space, clean color schemes etc.)

..0 “-
S“de element « Object manipulation
. * Shortcuts .
deS|gn « Efficiency tips .
Tactical et tttessssssssesrreesssssssssesEreesssssssESSeSEEeessssssEEEeSErEeessnssssrEenrrrees
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Objectives

» This session aims to improve our use and manipulation of objects and offer other tips
— Common problems tackled
— Use objects more easily and more often
— Make slides look more readable and professional

» It is designed for those who are familiar with

— Basic PowerPoint skills
» Creating new presentations
» Basic moving around the slide and presentation, and use of objects, text etc.

— Basic Mu Sigma templates and Mu Sigma Way

» This does not intend to be a Mu Sigma Way or ‘best-practice’ guide
— There are many ways to do most the ideas here — usually only one is offered

— There are many more methods and tricks out there
» Investigate and let me know

» Graphs and tables will be the next session

Mu Sigma 4
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Having the right toolbars allows easy creation, editing and
positioning of objects

» When objects are chosen, there are various drawing tools available in the “Format”
menu:

— Object ‘order’ buttons (Bring to front, send to back, etc.)
— Group and ungroup

— Shnap to grid, snap to objects

— Basic shapes

— Object and line properties

— Aligning functions

— Distributing functions

E"ﬂ H9-™ - PowerPoint tips vst - Microsoft PowerPaint Drawing Toals
)
—/J Home Insert Design Animations Slide Show Review View Developer Format
NN OO0 4] ¢z it shape - S shape Fill - A Text Fill - 3, Bring to Front ~ ;- Align = || 1) [g67-
ALLd G- — ~| I Shape Outline ~ A A : | &7 Text Outline » || B3 Send to Back ~ I8 Group .
_ & o P _ f _ — -
AN R B Text Box = ) Shape Effects = | [A\ Text Effects ~ || Iy Selection Pane 5 Rotate = || =24 CHE
Insert Shapes Shape Styles F] WordArt Styles F] Arrange Size

- ~ J H_J H_/H_/

Object Fill, line Bring to Group/Ungroup,
creation and font front, back  Align and
color etc. distribute,
Snap to etc
Mu Sigma
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Keep the ‘snap to’ option on for most occasions to help
create and move objects more easily

» ‘Snap to grid’ and ‘Snap to object’ should typically be on
— To position shapes or objects to the closest intersection of the grid, use Snap to Grid
— To position shapes or objects to grid lines that go through the vertical and horizontal edges of

other shapes or objects, use Snap to Shape

» How:

— Click the shape or object in the worksheet. Under Drawing Tools on the Format tab, in the

Arrange group, click Align

— Click “Grid Settings” and check the snap to grid or snap to shape options

— Use shortcut: Alt+V+I

Drawing Tools
Format

a ill - 0 ring to Fre - | 1Z Ali - .
éTcKt Fill i Bring to Front ||;1 Jign T [n.a7-

x A f - &7 Text Outline + | B sendtoBack = | |2 | Align Left

Text Effects » || iy Selection Pane | & | Align Center

WordArt Styles (F] Arrangsd S| | align Right

""" Qe el e e 2 3 0 4 T g Tap

A | Align Middle

uli | Align Bottom

Hle | Distribute Horizontally
& Distribute Vertically

v || Align to Slide

Pl T

| Spacing: | 0.083 % Inches
: [ ] pisplay grid on screen

¢ ﬁ Grid Setting =
N Grid Settings.. o
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Grid and Guides

Snap ko
snap objects ko grid
anap objects to other objects

Grid settings

4 Guide settings

[ Display drawing guides on screen

[Set as De[ault] I oK | [ Cancel
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Shift, Ctrl and Alt are (amongst) your best friends
» Use Shift

and/or Ctrl

and/or

in various combinations whenever you
— create an object
— move or rotate an object

— rescale an object

Mu Sigma
Confidential
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Using Shift when creating an object or line makes them well
proportioned or orthogonal

» SHIFT maintains the object’s proportions o :
— Select the autoshape type to create 7|—
— Hold SHIFT down as you drag to create it e

» Squares are created instead of rectangles

» Circles instead of ellipses

» Lines drawn are horizontal or vertical

» Stars are well proportioned ><

Mu Sigma
Confidential
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Using Ctrl when creating an object draws the object centered

on the first mouse click; Alt overrides ‘snap to’ options

» CTRL creates the object centered on the first mouse click
— Select the autoshape
— Hold Ctrl down as you drag to create it

» E.g. circles, ellipses and stars are created centered where you start drawing

-

withou with

» ALT makes the movement ‘smoother’, overcoming any ‘snap to’ settings

[TAT] - “orecooofh

Mu Sigma 12
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Alt @
Effective positioning of objects can be achieved using
the Shift, Ctrl and Alt key when dragging and dropping

* Left click to drag an object — release the left forefinger to drop it

Alt R

» Hold down SHIFT while dragging to move it horizontally or vertically on the screen

- .

Alt

Mu Sigma 14
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Copying is easy using the Ctrl key, while the Alt key
overrides the ‘Snap to’ option

* Hold down CTRL while dragging, to copy the object

N

Alt

» Hold down ALT while dragging, to move it ‘'smoothly’, overriding the SNAP to grids,

guides or objects

Shift
Mu Sigma 15
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Shift Ctrl

The Shift, Ctrl and Alt keys can be used together

* Hold down CTRL and SHIFT while dragging, to copy the object while moving it
horizontally or vertically

N

Alt

» Hold down SHIFT and ALT while dragging, to move an object horizontally or vertically
and ‘smoothly’ (overriding the ‘SNAP to’ option)

f S
At

Mu Sigma
Confidential
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Shift Ctrl Alt @
-
An object can also be moved by pressing the arrow keys
— CTRL makes it take much smaller steps each time

* The arrow keys can move any object
— Useful for basic orthogonal motion

- m

Alt

» Hold down CTRL while moving for ‘baby steps’

N

Alt

Mu Sigma 17
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Shift Citrl Alt

Objects can be rotated using their green handle

Rotate around center Rotate around edge

Pivot

Without & =il Alt With

Rotate at 15° intervals

Useful for 45° or
90° rotations

Mu Sigma With Shift

Confidential
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Shift Ctrl

Line can be stretched or rotated by dragging their ends

and using SHIFT, CTRL and ALT

Pivot

Move one end only

-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-
-

Without & =il Alt

Move along its axis only

O o____I_

Mu Sigma
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Move around center
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Use ‘Align’ to, well, align objects

Drawing Tools

Format

&Tex‘t Fill = ‘4 Bring to Front - |= Align = &1 2 2p- -

g A __.-’ - gTex‘t Cutline = LE;f,Sem:It-:u Back ':.‘l‘;“‘,ﬁ_”gnL_eﬁ _ Left
= Text Effects = I1’[}Sele":ti-:ur1 F‘ane..' & ‘--‘-‘-.Iigngenter _ Center
WordArt Styles E ATADE S Blign Right 4= Right
E gt i-.lignI-:up - Top
e | o _-'r:.lignuiddle 4= Middle
"“ﬁ:.-*-.lignﬂ-:utt-:um - Bottom
te o

Distribute Harizontally

Distribute Vertically

<. | Hie

Align to Slide

View Gridlines

H#f Grid Settings...

The red boxes are all aligned Middle
A

~

generation
analysis

5 g
E E
g s
E 7]
f=]

g 3

Hypothesis

5
= o
- £
g s
= =
o =
=
=L

Exploratory data
Model validation

Mu Sigma
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Use ‘distribute’ buttons to neatly space out groups of
objects

» Select objects and in format tab:

Drawing Tools
Farmat
ﬁTe:d Fill = ._J; Bring to Front - [|= Align = Ml -
\ A W\ PText outline - | By SendtoBack T | |2 Align Left Traini

7| [\ TextEffects » || By Selection Pane ng

T

1

Align Center

Waorddrt Styles s Arrangs Align Right

1l

Align Top

=

Align Middle

=
=

Align Bottom

0
J

>
A
-

F

Distribute Horizontally

a
» Distribute Vertically
® o)

Traini

Align to Slide ng
v | Align Selected Objects : : :

Yiew Gridlines

# Grid Settings... P

i i Equal spacing
between objects

Mu Sigma 21
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How can this be quickly made?

Mu Sigma
Confidential
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Create one Copy it four
object - times to
roughly the
- right place by
- dragging it
with CTRL
key down
|
Position the - ‘Distribute’
bottom right vertically
object -
]
]
]
() .
J- Distribute
horizontally
]
]
]
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How can these objects quickly be made?

Wag cell IE7
Plan Dosign amnd
G e R ation — Plasn .D'E'Sf-gﬂ and
Stmhg."c Effort Allocation GO ication —
SEHIOR Poifolio Bﬂ!ﬂ_wce and
MANAGEMENT Profiabitity
Bonchmarking, HUMAH
Liability RESOURCES/ MARKE TIHG
LE GAL
A
¥ Phan Design and
=l [ Commurication —
Hevenues and
» "‘ A Nt rration
SALES ADMIN/
s FIELD SALES
Jformation Systoms
Compatibility, Data
Availabiity & Sakes FINANCE
Administration
Costs, Rudgels, Fecal
Rk amd Accraal
Mu Sigma 23
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Here’s one way

1. Draw a hexagon using 4. Drag and copy a hexagon

horizontally using i BNe
to keep shaie in proportion --

2. Ensure ‘Snap to object’ is on
Grid and Guides

Rk . .
*[“I5nap objects to grid 5. Move It over using and
'-’:_inap objects ko other objects arrow keys

3. Drag and copy a hexagon using

Mu Sigma
Confidential
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Here’s one way

6. Drag and copy down two more,
using snap to object and

7. Drag and copy down one more

vertically, using snap to object
anct (IR

Mu Sigma
Confidential

8. Adjust up using arrow keys and

9. Select all, zoom in and drag a
handle of one in with
to smoothly resize

from t!e center of each object

25
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LG
The two color gradient within an object can be an attractive fill
effect

» Select the object and right click.
» Click on ‘Format <object>’

Format Shape

Fil || Fin

Line Colar O Mo fil
Line Style ‘{;?'_ sqlig fil . . ..
[ © . LN
sracon PRSI
'O' Picture or texture fil
2
o remet O slide background fil
3-D Rotation
Preset colors:
Picture
Type: Limear w
Text Box
Direction:
Angle: 270° |2
Gradient stops
]
R ST e [ Add ] [ Femoye ]
Stop 1 L - _
@ H 0%
Stop2 M —
«;.smp 3 E
Y .
Transidiéney: (J———

Rotate with shape

Mu Sigma 27
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LG
Patterns within an object are also useful fill effects, especially
for printing

Format Picture E|E|
» Select the object and right click. Choose ‘Format <object> | .,
— From fill=> choose ‘Picture or texture fill’ t ;'I 8 S
— Options include fills from files, clipart and the clipboard Shado O gradientfi
A 50 Format g E::urbe DL texturdeﬁi;"
(after copy action) o de backgroun
7 nataten Texture:
_______ —_ Picture ‘IlsErPffan;.-........."l..
- - It N Text Box "‘ [ File... ] [ Clipboard l [ Clip Art... ] :l
,/ ~,\ 'Emhww.qitsx;uﬁe..-------.-‘

/. B Tiling options

N Offset: [0pt 2| sealen: [100% %

‘ Offsgt': [opt 3| sealer: 0% %

\ Alignment:

"\ Mirrar type:
~ T~ . : Transparency: J 0% £
T Rotate with shape
Prospects
CRM
database | S"’E|7e§ 9d75)‘ta
(35,561) '-\ )
.‘\'.
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Think about line thicknesses and line types to help with
clarity

Format Shape

% of Sales

100%

Concentration of Sales

90% -
80% A
70% -
60% -

50%
40% -
30% A
20%

10% -

0%
0%

10%

20%

30% 40% 50% 60%

% of Customers

70%

80%

90%

100%

Fil Line Style
. EEEEEEEEEREP ~
Line Color a Width: . Line thickness
. - u
Line Style aCompound typesd
-
Shadow . . .
2Dashtyper = Line type
3D Format o =
3D Rotation o .
Picture Elu:uin type: . Miter b
mArrow settings .
Text Box o :_._
o Beqin type: F = [ End type: E -
-
« Beginsze: |= w | Endsize: E
- .
G EEEEEEEEES
Mu Sigma
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Connectors stretch as you move a connected object. All
PowerPoint 2007 lines are connectors

These are
connectors and
not ordinary

‘lines’

HLEERE N @ -

Table || Picture Clip Photo [Shapes|SmartAt Chart | Hyperlink Action
- At Album+| -

Tables Hlustt)  Recently Used Shapes
siides. N Qutined. . x|, ENN\OOODALLD [
‘Qg,g,m{lllll....

®.7 Lines
E | N M ERENANE) %

U’ 20w i g i o® L

B Basic Shapes
v v /47, v N EEINa)aXeXeTatcloto]
lPGodor Ly SO
EOE@CHEOV G (<D™
Qo1
| Block Arrows
P etdQueLppsa
e 2wanDD »Rdai
o dr A
.| Equation Shapes
E=R==4g
Flowchart
Oo<0nidSdcoay
lovanes s s avaD
Qaged
Stars and Banners

R COeCEREe

DR
Home Insert Design Animations Slide Show Review 1

214

I
g

2 [
g

L4

\d

Connectors
stretch as you
move objects

Move the box...

Mu Sigma
Confidential
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Objects are placed in front of other objects when they are
created but may need ‘sending back’ if necessary

1. To add alight background
shading to parts of a slide

2. Create a box roughly covering
the area of interest

3. ‘Send it back’ using

Drawing Tools

Format
-----

éTeﬂ Fill = .fl, Bring to Fr:nt" |_—| Align = '"IJ 047"
A ! - ETen‘t Cutline - .'Ea Send to Bacl’ 9.% Group )
11 — = osT
Text Effects = Q’i\@ SeTe.ctT:n'n‘Pane Sk Rotate = || vo* 087
WordArt Styles (] Arrange Size

4. Resize it to fit using if
necessary to override ‘Snap to’

Mu Sigma
Confidential

O

‘ 40% ‘ 40% ‘ZO%

40% 40% 20%

Sales potential
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LG
The concept of front and back is important for building
shapes on top on each other

» How is this created?

* Answer: with
three objects

......

Back Middle Front

* With two objects, you can create this:

Mu Sigma
Confidential
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Alternatively you can make colors partly ‘transparent’

Format Shape |E||E|

=T

Line Color ) Mo fill Prospects
Line Style ® soldft 0 -
- ‘.
) .- ~

shadom ) Gradient fil R .

) Picture or texture fil / ..
FOFermat | Siide background fil i
3-D Rotation Colors .\
Picture gunnnnt """"""""':v-... .

',.Iransparen-:y: ‘_J_ B |5 . \.,
Text Box .....lllIIIIIIIIIIIIIIII-----“‘

Close

Mu Sigma 33
Confidential



Bullets in a box need some formatting before they’re ready
» Creating bulleted text inside an object can look like this

*Here’s my title

*Here’s another

*These are some bullets

*They look pretty average, especially if they overrur} the box size

* Consider:

Mu Sigma
Confidential

Making the header bold

Left justifying

Wrapping the text in the box

Possibly, resizing the box to fit the text

Here’s my title

*These are some bullets

*Here’s another

*They look pretty average,
especially if they overrun the box
size

i

Format Shape

Fil Text Box

Line Calor Text layout

Line Style Vertical alignment: | Middle
shadow Text direction: | Horizantal
2 )

3D Format Autofit

- )

3D Rotation (® Do not Autofit

Ficture ) Shrink text on overfloy

W

Text Box ) Resize shape to fit text

Internal margin
Left: 0.1" Eo
Right: |0.1" -
[] wrap text in shape

Columnis. ..

Top:

Bottom:

0.05"

4[4

0.05°

Close

34




LG
Finally use the ruler when editing to get those bullets looking
the way they should

Here’s my title Here’s my title

*These are some bullets * These are some bullets

*Here’s another * Here’s another

*They look pretty average, » They look pretty average,
especially if they overrun the box especially if they overrun the box
size size

BN NOoO - MY

ALLDL O ,._r;n
tat- || 2 O T T
“--ﬁ--.,’ Drrawir
* *
usetherulerandtabsﬂ:,'?'a"";:'1"""'2"""

4
LTS A

o get those bullets Ic

o

Here's my title
. I'Fhese are some bullets
» Here's anaother

* Theylook pretty average,
gspecially if they overrunthe box

when editing text in an object =)

size

Mu Sigma 35
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Use ovals and callouts to highlight relevant numbers of

Interest

Mu Sigma
Confidential

Valuation tables for Soriatane and Extina markets

Overall prescription data

Soriatane
Decile No. of Avg Mkt | Avg Soriatane
docs TRx TRx
10 219 2,819 1
9 337 1,840 3
8 443 1,396 2
7 608 1,022
Ol
6 926 667 o .
: K
5 1,653 374 HEE VI
H »
4 3,395 184 % 10 L
S
3 7,840 78 3
2 22,434 29 1
Note: the relatively high
1 110,368 5 0 proportion of Soriatane
0 43145 0 0 prescribers in the mid-
. deciles may reflect those
Total / 191,368 32 1 active doctors who tend
Avg not to prescribe biologics

Note: Average market TRx represents the ‘value’ of that decile

compared to other deciles

Source: NDC Health, Confidential and Proprietary, prescription data, 12 month to April 2004

©2004 ZS Associates

—-19 -

Extina
Decile No. of Avg Mkt
docs TRx
10 784 916
9 1,640 440
8 2,630 272
7 4,232 171
6 6,733 108
5 10,143 71
4 15,193 47
3 24,304 30
2 42,046 17
1 182,363 4
0 71,616 0
Total / 361,684 20
Avg

Connetics Data Review 2004_06_10 1.0

36



LC
An object can be converted from one autoshape to another,
without recreating it

» You create an object with complex properties (color, text boxes, shadows etc.)

» You want to convert it to a, probably, slightly different type of object
— Select the format tab
— Select ‘Edit shapes’> 'Change shapes’—> select a shape

.'1"9 HY-™ )+ PowerPoint tips vst - Microsoft PowerPoint u&.ﬁg'ro'm?.
. Hom Iniert“ﬂiﬁrF o !rﬂrr.t@rg Slide Show Review View Developer
* . )
B e o W o NN ‘i’
E E % l_k \’: @ Change Shape L3 Jedang\es A A
— Sh“'@ Conyert to Freeforng “DDDDDD HE&EE
QSer Snap :-_:. Tnpmus® Basic Shapes E
r: CANOOGOOOOO®
{COO@EF LBO0EOO
o@a Om%ﬁ(wﬂm
G0 ) L%

. Block Arrows Heart DO the

Do the math! B DEGTETHFLPRI T hi
: € vnDD D DLEan matn!

(o) O N 4}‘3:}‘1:3}

o - Equation Shapes

F=R==g

Slides CQutline

Flowchart
Oo<cioolideoay
cnadn®®d E ¢ AVED
Qoo

Stars and Banners
MR W XDOLERES
2223 [T PRI
- Callouts
EOQC3/DH:||'\DA Al AL
o AD AD g

Action Buttons

(=] (=1 =] 1) ] [ (] [ [0 (6] (51 ]~

Mu Sigma 37
Confidentia



Use the mouse scroll wheel with CTRL to zoom in and out

» Use it when working on objects, charts or small text

» Makes it easier to move objects off completely off the slide, make edits and then move
back

Mu Sigma 38
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Before printing, always check your slides by viewing ‘black
and white’

» The default for printing is ‘black and white’ slides
— This is true even if the printer is very capable of printing in ‘grayscale’ as most are

— This can lead to slides looking different on the screen to the handout
— And not as you intended

» However, black and white is best for photocopying and faxing

Mu Sigma
Confidential

Color

Customers

Customers

Customers

Customers

Customers

Customers

Grayscale

Customers

Customers

Customers

Customers

Customers

Customers

Black and white

Company
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‘Black and white’ printing can be overcome (if desired) in the
print options or by selectively changing object properties

» If grayscale is preferred or necessary for printing
— Print the whole document in grayscale
» Select grayscale from the print menu
— Select objects as grayscale for printing
» Click View ->Color/Grayscale /Pure Black and White
» Select the objects
» Right-click and choose ‘Grayscale’

P - =
( n@ H9- 0
~ Home Insert Design

PowerPoint tips vst - Microsoft PowerPoint Drawing Tools

Animatia Slide Show Review View . P S BN wFgrmat
= . . L =
= [ ] = ¥| Ruler P M cotor * B Arrange All =
=l B 5 ] aCa! =
o Gridlines E Grayscale 1] % Cascade —
Mormal| Slide MNotes Slide Slide Handout Motes Zoom ®itto @ New = ) Switch Macros
Sorter Fage Show | Master Master Master Message Bar vi¥gow || bl Pure Black and Whitg ™ wingow G5 Mave Spiit | wingows -
Presentation Views Show/Hide Zoom . oy n galinﬁrﬁ'iﬁﬁ ‘Window Macras

Note: the hidden stem
of the speech bubble

Color (on is printed unless the
object properties are
screen) set to ‘Grayscale’

Od_ocal
O.

business

priorities?

Black and
Mu Sigma white

Confidential

Prinker
bame: |=£ 11192, 168,16, 26)L5_137_HP1320 v |
- iz Find Printer...
Type: hp LaserJet 1320 PCL Se
Where: L5-'W5-137
Cormment:  L5-WS-137 [ Prink ka file
Prink range Copies
® all (O current slide () Selection Number of copies:
Custom Show: | | 1 <
(O slides: | |
Enter slide numbers andjor slide ranges. For example,
1,3,5-12
Collate
Print yhet® = = 5 a, Handaouts
kﬁdes * | I:I R
* (I
: Colorfgrayscale: _‘ Horizontal ‘ertical EE
w| |Calor 1*|m
]
| fColar ™ [ scale to Fit paper Print hidden slides
9 |Gravscale N ) ) '
\pure Black and White o | L Ftame slidss [(High gualicy

r3 +
4, “‘

Preview

Print comments and ink markup

I OK l [ Cancel

Grayscale selected

as object property 40
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Sample slides people have liked or used

Project status
Note use of: . . . . . 4
. Boxes This meeting will complete the first phase of the project,
Highliahted allowing the project to move to market segmentation and the
L] - -
\ghiighte Delphi meeting
areas
* More ) Phase Objectives
InterEStlng ‘IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII.‘
than bullets : Immersion and . Undlfrstand the current situation facing each product, including issues, forecasts, and future .
u market events =
alone E database * Generate market and audience insights .
m development * Develop a physician-level database to support market segmentation, segment valuation, and ¢
" historical sales response analysis Ul

.IIIIIIIIIlllllIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII'

* Conduct segmentation analysis for physicians based on market potential and historical

Segmentation prescribing behavior

n | . - . ) . .
and sales ¢ Utilize statistical methods to derive frequency response relationships across products in the
respon_se Connetics portfolio
analysis * Review historical data to understand sales force call capacity and audience access
constraints
¢ Estimate future promotion responsiveness by product and customer segment given new
Judgmer.wtal indications, changes in the competitive landscape, etc.
forecasting * Conduct interactive promotion response review session with Connetics project team (field
sales, sales operations, brand team, senior sales and marketing management)
o * Determine the optimal size of the sales force and the optimal allocation of effort by product to
Sizing and each customer segment
flnanC|_aI * Determine financial implications of different audience coverage and sales force investment
analysis scenarios (sales, profits, ROI)

¢ Assess different risk scenarios to facilitate selection of the optimal sales force strategy

©2004 ZS Associates -5- Connatice Data Raview 200 08 1010

Note: these are indicative only of techniques discussed today. They are not Mu Sigma Way approved by the Mu Sigma Way authorities (although they
may conform!). They are slides | like, other people have liked or have used as templates

Mu Sigma 42
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Sample slides people have liked or used

Note use of:
* Boxes
* White Executive Summary
areas
* More
interESting * We recommend the sales force size be increased to 122 reps
than bullets Team size — This increase is driven by the significant opportunities of the soon-to-be
alone launched products, particularly Velac, as well as line extension of OLUX

(OLUX-E)

Team * We recommend the sales force be mirrored with two teams of 61 reps
structure — This suggestion is a result of the increase in total number of products, the
importance of high frequency detailing, as well as the benefits of easier
coordination and more efficient management

* Dermatologists should continue to be the primary audience

Husleres * Analysis shows that PCPs, which are typically in low to medium deciles, draw a

reasonable additional number of reps for the two acne products but with relatively
little additional sales

* Pediatricians require very little rep effort and are therefore responsible for almost
no additional sales
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Sample slides people have liked or used

Note use of:
» Two-color
gradient

* White
space

» Colored
headings
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Data review

The project will focus on eight products in the period to 2007

* The assumed launch dates will influence the product
forecasts used in the base case

* Alternative launch dates (i.e. forecasts) will be
possible as scenarios

Product Launch date
(best estimate of
‘street’ launch)
Actiza Dec 2004
Extina Mar 2005
Velac Aug 2005
OLUX-E Oct 2006
Desilux Feb 2007

Desilux

| [l

Current marketed
products

©2004 ZS Associates -9-

Timeframe of
project is to
end of 2007

Connetics Data Review 2004_06_10 1.0

may conform!). They are slides | like, other people have liked or have used as templates

Mu Sigma
Confidential

44



Sample slides people have liked or used

Note use of:

* Colored
headings

+ Highlighted
areas of
interest
with callout

Note: these are indicative only of techniques discussed today. They are not Mu Sigma Way approved by the Mu Sigma Way authorities (although they

Valuation tables for Soriatane and Extina markets

Overall prescription data

Soriatane
Decile No. of Avg Mkt [ Avg Soriatane
docs TRx TRx
10 219 2,819 1
9 337 1,840 3
8 443 1,396 2
7 608 1,022 4
Ol
6 926 667 0 .
. K
5 1,653 374 P14
H "
4 3,395 184 % 10 [
0..‘€
3 7,840 78 3
2 22,434 29 1 - -
Note: the relatively high
1 110,368 5 0 proportion of Soriatane
0 43.145 0 0 prescribers in the mid-
. deciles may reflect those
Total / 191,368 32 1 active doctors who tend

Avg

not to prescribe biologics

Extina
Decile No. of Avg Mkt
docs TRx
10 784 916
9 1,640 440
8 2,630 272
7 4,232 171
6 6,733 108
5 10,143 71
4 15,193 47
3 24,304 30
2 42,046 17
1 182,363 4
0 71,616 0
Total / 361,684 20
Avg

Note: Average market TRx represents the ‘value’ of that decile
compared to other deciles

Source: NDC Health, Confidential and Proprietary, prescription data, 12 month to April 2004

© 2004 ZS Associates
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Sample slides people have liked or used

Overall prescription data

Note use of:
« Different . .
| Although OLUX and Soriatane may be considered as
CcoOIS — complementary, the overlap of high prescribers? is very low
 Different line
types and * Soriatane
thicknesses
’/ - ‘ .\‘.\ .........
‘/. N. ettt e
7 e T
7 N
! SN
/ HE
OLUX g __ %
@547) | 4,516 tanl 1,576 :
| - | & Soriatane
\ ] < (1,607)
\, LA -
\, 2T L
« ;
N 7
~ . /.‘/‘

e e

Overlap of decile 7-10 physicians
in the OLUX and Soriatane market

1 Deciles 7-10 are considered as ‘high decile’ doctors
Source: NDC Health, Confidential and Proprietary, prescription data, 12 month to April 2004

-24 - Connetics Data Review 2004_06_10 1.0
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Sample slides people have liked or used

Note use of: Prescription data by specialty
* Mu Sigma . e .
W ca0h About three quarters of all scripts for existing Connetics
ay grapns products are written by derms
and colors
« Simple
bullets Proportion of Connetics scripts (TRx) by specialty
100% -
11% 10%
80% 1 Az 0 o m Other
UNK
60% - = PD
PCP (FM/IM/GP)
40% - =D
0O RHU
20% A
0% -

Luxiq Total Olux Total Soriatane Total

* Very few pediatricians currently write Connetics scripts
* PCPs write 7-10% of Connetics scripts
* Negligible Soriatane scripts are written by rheumatologists

Source: NDC Health, Confidential and Proprietary, prescription data, 12 month to April 2004
Specialty codes. UNK: Unknown, PD: Pediatrics, FM: Family Medicine, IM: Internal Medicine, GP: General Practice, D: Dermatology, RHU: Rheumatology
Top 4 specialties in the ‘Other’ category typically consist of OTO (Otolaryngology), OBG (Obstetrics/Gynecology), EM (Emergency Medicine), NEP (Nephrology)
© 2004 ZS Associates - 31 - Connetics Data Review 2004_06_10 1.0
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Sample slides people have liked or used

Note use of:

* PowerPoint
graphs that
can include
table below

* Mu Sigma

Way colors

e Grid lines
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Forecast sales to 2007 will be used in the analysis

Financial assumptions

Forecast sales ($MM)

BBBO e

$300 A

$250 A

$200 A

$150 A

$100 A

$50 -

$0

2004 2005 2006 2007
Desonide-E $0 $0 $0 $11
u Velac $0 $24 $112 $140
W Extina $0 $6 $17 $23
B Actiza $0 $18 $30 $39
Soriatane $55 $54 $29 $20
B Luxiq $24 $26 $28 $29
OLUX-E $0 $0 $4 $10
m OLUX $60 $66 $64 $59

© 2004 ZS Associates
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Desonide-E

m Velac

B Extina

B Actiza
Soriatane

B Luxiq
OLUX-E

m OLUX

Note:

OLUX, OLUX-E
and Luxiq:
excludes PCP
forecast

Actiza, Velac,
Extina, Desonide-
E: includes derms
and non-derms

Soriatane: derms
only

Connetics Data Review 2004_06_10 1.0
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Note use of:

Note: these are indicative only of techniques discussed today. They are not Mu Sigma Way approved by the Mu Sigma Way authorities (although they

Simple graph
(Appendix
page)
Callouts
White space

Sample slides people have liked or used

Appendix - Product share for each market

Product breakdown for Extina market

35% -
30% -
25% -

20% -

Source: NDC data, 12 month to April 2004

© 2004 ZS Associates

30%

22%

Note: Loprox topicals
and shampoo are a
significant proportion
of the market, and
are an OTC product

Note: Lamisil
and Lotrimin
proportion is
very low
(Nizoral A-D
was not included
in the NDC data)

0% 0% 0%

-52- Connetics Data Review 2004_06_10 1.0
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Sample slides people have liked or used

Note use of:

* Border and
shading for a
screenshot

* Bubbles for
‘questions
asked’

Note: these are indicative only of techniques discussed today. They are not Mu Sigma Way approved by the Mu Sigma Way authorities (although they

Sales response

We must consider and agree the value of additional details for
each product, which will help build up the sales response curve

Example questions

“What is the likely
maximum number of
calls for this product?”

“How competitive is this
market?

“Would it be more
effective to direct the
maximum number of
calls to one doctor or

split them between

two?”

© 2004 ZS Associates

llustration
Promotion Response Curves
Maximum P1 Equivalents for High Value Decile MD 2 |
Proposed P1 Equi per MD 0 8 16 24 2 |
% of Affectible Sales Achieved 0% 55% 80% 88% 100% I
[Alternative P1 Equivalents per MD 0 8 16 24 32 |
% of Affectible Sales Achieved 0% 65% 87% 94% 100% |

Affectible Sales Achieved By Effort Level

100%

—=&— Proposed

—A— Alternativ

ke ==
—k

-
2 7%
5 A”
<
p //
& s0% >
©
2
E 7,

25%
<
5 Y
8

% : : : .

0 8 16 24 32

P1 Equivalents
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Sample slides people have liked or used

Situation

Note use of:

* Clear
structure

* White space

* Well
‘distributed’
objects Arms race

» Consistent
Mu Sigma
colors Blockbuster launches

+ Shaded
background
boxes Access problems

Many pressures in the pharma market lead to the most valuable
customers being shared by many reps

e
> Customer

‘
‘

“Frequency works”

11l

Multiple products

© 2005 ZS Associates -3- Synch Selling brown bag 022805 v3.0
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Sample slides people have liked or used

Process

Note use of:

* Clear
graphics

* White space

+ Well
‘distributed’
objects

The forecasting process needs to be balanced to ensure
usability and longevity

y ]
y

Process Technical
Focus Focus

© 2003 ZS Associates -29 - XpertFcast_032603 v1.1
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Sample slides people have liked or used

Note use of: Sales Response
* Clear
graphlcs Sales Response curves for all products agreed in Delphi meeting
* White space
* Colors
» Line types
for gridlines
100% - R S
——_ = =T
-— - - & }/:f— -
° / D) s SO T j@tan e
z 75% | e VS o a ,//f Extina
£ 7/ i
2 I/ . 4 f‘ Actiza
% / - - pf" /f" Velac
‘g 50% r /' p / / wmenmeem DESilUX
E / s / 7 4 // Luxiq
k: / e /4 / — — OLUX-E
< /o P — - - OLWX
Dg 25% - // ’/ g
/4 f _
o i ! ! :
0 8 16 24 32
P1 Equivalents
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Sample slides people have liked or used

Note use of:

* White space

* Colors

» Line types

* Well
‘distributed’
objects
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Overview / Structure update

The team has progressed through the sizing analysis and into

the deployment planning

Feb March

C\ """ \\ 4
/‘ A Sales force structure
2] 4

Jmmmmmmmm————— N =
N . H

:. » Sales force size :

D 2 — v H

Steering committee
meeting

© 2005 ZS Associates

Today
: April

LM
i M
MB deployment plan

MS éieployment
‘i iplan

HID deployment

May

HI Compensation and other effectiveness issues

June

ABI steering comm mtng 4.06.05 v1.0
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Sample slides people have liked or used

Note use of:

* White space

+ Aligned and
distributed
objects

* Lines
directing
eyes to text

* Simple
colors

Note: these are indicative only of techniques discussed today. They are not Mu Sigma Way approved by the Mu Sigma Way authorities (although they

We win when we...

When do we win?

Go in prepared

Convey our value

.. /
proposition /!

©2005 ZS Associates

Current clients are still the key source of new IC projects

— Good work in SSA, Deployment, Market Research, etc.
will foster our credibility and allow us to broach Incentive
Compensation as a practice area

IC work results in interaction with a significant portion of
the client organization

— Opening doors for other possible project work

Clients remember when we provide excellent service
— Client contacts often migrate from one firm to the other,
but generally stay within the same industry
— Clients also refer us to their colleagues — but only if they
received the full ZS Way treatment

—40 -
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